
Chapter 2

Installing and Running the NMC-RX
Application

This chapter provides procedures for installing the NMC-RX Element Management
System and its components on a Windows or Sun Solaris system.

System Requirements

To run the NMC-RX application, your system (Windows or Solaris) must meet
certain requirements.

Windows
To run the NMC-RX application, your Windows system must meet the following
minimum requirements:

CD-ROM drive

Windows 95/98, Windows 2000, NT 4.0 or later (preferred)

128 MB of RAM

330 MB of space on the hard drive (when installing)

266 MHz
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Solaris
To run the NMC-RX application, your Solaris system must meet the following
minimum requirements:

CD-ROM drive

Solaris 2.7, Solaris 2.8

128 MB of RAM

300 MB of space on the hard drive (when installing)

266 MHz

Solaris software patches 108940-50 and 108652-66 are required to install the
NMC-RX application on Solaris 2.8. To find the required patches for your system,
visit the Sun support Web site:

http://sunsolve.sun.com/pub-cgi/show.pl?target=patches/patch-access

Installing the NMC-RX Application

There are five installation sets to choose from when you install the NMC-RX
Element Management System.

NMC-RX and Sybase – Installs Sybase SQL Anywhere, the NMC-RX Element
Management System client software, Polling service, ConfigSync service,
Provisioning service, and the NMC-RX database schema.

If this is your first installation of the NMC-RX application, choose this
installation set.

NMC-RX – Installs the NMC-RX Element Management System client software,
database schema, Polling service, ConfigSync service, and Provisioning service.
Installing the NMC-RX Application
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If you plan to uninstall a previously installed NMC-RX application and reinstall it
again, and you have either installed the Sybase database on this system or the
Sybase database is accessible on another system, choose this installation set.

NMC-RX Client Only – Installs only the NMC-RX Element Management System
client software.

If Polling service, ConfigSync service, and the Sybase Adaptive Server Anywhere
database have been installed on another accessible workstation on your
network, you may choose this installation set.

NMC-RX PVS – Installs the NMC-RX Element Management System client
software and the Provisioning service (PVS).

NMC-RX Upgrade – Upgrades the currently installed components to the
version of the software being installed.

If you have a version of the software installed that is listed in Table 3 and want
to upgrade, choose this installation set. You cannot upgrade releases before
4.1.x using this feature.

To revert to a previously installed version of the software after performing an
upgrade, see Reverting to a Previous Softw are Installation later in this chapter.

NOTE: When you run the NMC-RX software, you must have Sybase Adaptive
Server Anywhere installed on your system or on another system that is accessible
on the network and already running.

Table 3:  Software upgrade compatibility

If You Have This Version Installed You May Upgrade to This Version

4.1.x 5.0.x, 5.1.x, 5.2.x

5.0.x 5.1.0, 5.2.x

5.1.x 5.2.x
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See Table 4 for a description of each component.

Installing or Upgrading the Software

To install or upgrade the NMC-RX application:

1. Insert the NMC-RX CD in your CD drive and perform one of the following:

Windows: If the installation program does not autoplay, double-click
install.exe in the Windows directory on the CD drive.

Solaris: Run install.bin.

2. Follow the instructions that appear on the screen.

3. When the installation is finished, perform one of the following:

Windows: Click Done and reboot your system.

The installation places a shortcut on your desktop for each application and
service that you installed.

Solaris: Click Done.

Table 4:  NMC-RX application components

Application/Service Description

NMC-RX Element Management
System client software

Provides capability of managing devices on your network via a
graphical user interface (GUI)

Sybase Adaptive Server
Anywhere database

Provides database services and connections needed to run the
NMC-RX application

Polling service Provides the NMC-RX application with the status of managed
devices based on a defined polling interval

ConfigSync service Enables the NMC-RX application to discover or update a device
on the network and builds a model of the device in the
NMC-RX database

Supports the application’s configuration save and restore
function

Resource Configurator Provides an efficient graphical interface for setting up SNMP
and the Sybase, Polling, and ConfigSync service parameters

Provisioning service Provides an optional, programmatic application programming
interface (API) for integration with the NMC-RX Element
Management System application

NOTE: Before upgrading the NMC-RX software, make sure all NMC-RX processes
are shut down.

NOTE: To obtain an NMC-RX or Provisioning service license key, please contact
your Juniper Networks sales representative. If you would like to change your
license key, see Modifying Your License K eys on page 18.
Installing the NMC-RX Application



Chapter 2: Installing and Running the NMC-RX Application
Before Running the Application
To run the NMC-RX application, Sybase Adaptive Server Anywhere must be
installed on a machine that can be reached by the NMC-RX application.

Before you run the NMC-RX application, run the Resource Configurator to verify
that the settings for the database, SNMP, the Polling service, and the ConfigSync
service are correct. You do not need to run the Resource Configurator each time you
run the NMC-RX application.

You must start the database service before running the NMC-RX application. We
recommend that you start the Polling service and the ConfigSync service before
running the NMC-RX application.

NMC-RX Application Components

The following sections describe each NMC-RX component.

Resource Configurator
Before you run the NMC-RX application for the first time, you must run the
Resource Configurator to set up the NMC-RX parameters.

Running the Resource Configurator on Windows
To run the Resource Configurator from your desktop, double-click the NMC-RX
Resources icon on your desktop.

To run the Resource Configurator from the NMC-RX application (after the initial
configuration):

1. From the Tools menu, choose NMC-RX Settings.

The NMC-RX Resource Configurator launches.

2. Configure the settings for each of the available services.

Running the Resource Configurator on Solaris
To run the Resource Configurator from the shell:

1. Enter cd <NMC-RX installation directory>/bin

NOTE: Scripts that launch NMC-RX applications and services are available for
Solaris installations, and can be found in the <NMC-RX installation
directory>/utils directory. See Using Solaris Scripts on page 18.

NOTE: If Polling service or ConfigSync service are running on this workstation, you
must restart each service so that changes made in the Resource Configurator are
reflected.
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NMC-RX 5.2.x User Guide, Vol. 1

14
2. Run ./NMC-RXResources to configure the database, SNMP, Polling service, and
ConfigSync service.

To run the Resource Configurator from the NMC-RX application (after the initial
configuration):

1. From the Tools menu, click NMC-RX Settings.

The NMC-RX Resource Configurator launches.

2. Configure the settings for each of the available services.

Database Service
You must start the database before you can run the NMC-RX application, either
locally or on a remote system (that is configured through NMC-RX Resources).

Starting the Database Server Locally on Windows
To start the database service, double-click the appropriate Database icon on your
desktop. If you are running the database locally, the Database icon appears in the
Windows system tray. This indicates that the database is available to the NMC-RX
application.

If you are running the database on another machine, you do not receive any
indication that it is running. However, if the NMC-RX application cannot connect to
the database, an error message appears.

Starting the Database Server Locally on Solaris
If you do not use scripts to run the NMC-RX application, you need to do the
following:

Set up the LD_LIBRARY_PATH to contain the Sybase ASA library directory. The
default directory is /opt/sybase/SYBSsa7/lib.

Set up the search path to contain the Sybase ASA bin directory. The default
directory is /opt/sybase/SYBSsa7/bin.

To start the database service, run nmcrxdb from the utils directory or from the
command line:

For the NMC-RX database connection, use:

dbsrv7 -ud -ti 0 NMC-RX.db

NOTE: If ConfigSync service will be running on this workstation, ifconfig -a
provides the Solaris IP address for FTP on the ConfigSync service tab.

NOTE: Be sure to wait until the database is initialized before launching other
NMC-RX components. If an error occurs, close all NMC-RX components (including
the database) and start over.
NMC-RX Application Components
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For the DemoDB database connection, use:

dbsrv7 -ti 0 NMC-RXDemo.db

Polling Service
You should run the Polling service before you run the NMC-RX application, although
it is not required. The Polling service generates a log of events.

You can configure the Polling service from <NMC-RX installation directory>/bin/
by running ./NMC-RXResources or using the Resource Configurator (available from
the NMC-RX application).

Some problems do not stop the Polling service from running or remaining active. If
any problems occur, check <NMC-RX installation directory>/log/PollingServer.log
for recent messages.

If you chose a client-only installation, no Polling service will be available on your
workstation. Polling service may be running on another machine that is connected
to the database.

Starting the Polling Service in Windows
To start the Polling service, double-click the Polling service icon on your desktop.
The Polling service console window opens. This window displays the ongoing
activity of the Polling service. If errors are encountered during startup, an error
dialog box appears.

Starting the Polling Service in Solaris
You can start the Polling service from <NMC-RX installation directory>/bin/ by
running ./PollingService or by using the polling script located in the utils directory.

ConfigSync Service
You must run the ConfigSync service before running the NMC-RX application so
that the software can find the devices that you want to configure. Once the devices
have been discovered, you can close the ConfigSync service.

You can configure the ConfigSync service from <NMC-RX installation
directory>/bin/ by running ./NMC-RXResources or using the Resource
Configurator (available from the NMC-RX application).

The most important configuration issues to remember are:

FTP destination IP address – Enter the IP address of the machine running the
ConfigSync service.

FTP login name

FTP password

NOTE: The registry port default is port 1099.
NMC-RX Application Components 15
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FTP destination subdirectory – Be sure the subdirectory is created under the
ftproot directory. It is case sensitive.

Local root directory – Case sensitive

If FTP is configured properly, the following URL should bring up an FTP
connection to the ifStack directory when placed in a Web browser address line:

ftp://your ip address here:21/ConfigSync/ifStack

To test further, use FTP to add a file to the ifStack directory and verify that it can
be seen and accessed.

Verify that the FTP Home Directory has been granted write permission.

Starting the ConfigSync Service on Windows
To start the ConfigSync service, double-click the ConfigSync service icon on your
desktop

If you chose a client-only installation, no ConfigSync service will be available on
your workstation. ConfigSync service may be running on another machine that is
connected to the database.

Starting the ConfigSync Service on Solaris
You can start ConfigSync service from <NMC-RX installation directory>/bin/ by
running ./ConfigSyncService or by using the configure script located in the utils
directory.

Provisioning Service
The NMC-RX Provisioning Service (PVS) provides an optional, programmatic
application programming interface (API) for integration with the NMC-RX Element
Management System application.

The NMC-RX database acts as a repository of information to be used both by
NMC-RX client GUIs and by clients accessing the NMC-RX application through the
provisioning interface. You must install NMC-RX Element Management System
software before running NMC-RX Provisioning Service.

Installing the NMC-RX Provisioning Service
The NMC-RX Provisioning Service package is installed along with the following
installation sets:

NMC-RX and Sybase

NOTE: The registry port default is port 1098.

NOTE: For more information about using the NMC-RX Provisioning Service, see the
NMC-RX Provisioning Service User Guide .
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NMC-RX

NMC-RX PVS

Full installation upgrades

Starting the NMC-RX Provisioning Service
NMC-RX Provisioning Service Release is a separately licensed NMC-RX component.
The four components that must be run in order to start the Provisioning service are:

NMC-RX Database service

CORBA Naming service

NMC-RX Provisioning RMI service

NMC-RX Provisioning CORBA Bridge service.

For information about starting and using the NMC-RX Provisioning Service, see the
NMC-RX Provisioning Service User Guide .

Running the NMC-RX Client

When you run the NMC-RX client, you must have the ConfigSync service running if
you need to update or discover devices. Running the Polling service is necessary
only when you want to display the status of the devices you are working with.

Starting the NMC-RX Client on Windows
To start the NMC-RX client:

1. Double-click the NMC-RX icon on your desktop.

The NMC-RX application splash screen and the NMC-RX User Authentication
dialog box appear.

2. Enter your username and password, and click OK.

The Network Workshop window appears.

Starting the NMC-RX Client on Solaris
You can start the NMC-RX application from <NMC-RX installation directory>/bin/
by running ./NMC-RX or by using the NMC-RX script located in the utils directory.

NOTE: When upgrading an installation that contains the NMC-RX PVS software,
any changes that were made after the initial installation are overwritten. In
addition, any modifications to the files found in the pvsSampleScripts directory
are lost.
Running the NMC-RX Client 17



NMC-RX 5.2.x User Guide, Vol. 1

18
Modifying Your License Keys

To modify your NMC-RX or Provisioning service license key:

1. From the NMC-RX client Help menu, click NMC-RX Licensing.

The NMC-RX Licensing Information dialog box appears.

2. To edit your license key, click Edit License.

The NMC-RX Licensing Information dialog box now shows an editable text
field, and the Edit License button changes to the Verify License button.

3. Modify the license string(s), and click Verify License.

If the license string(s) you entered is a valid license, the OK button is enabled. If
the license string(s) entered is a invalid license, an error message appears.

4. If the license string(s) is valid, click OK.

Using Solaris Scripts

Scripts provided for all NMC-RX application components can be found in the
<NMC-RX installation directory>/utils directory. The allnmcrx script launches the
NMC-RX database and all NMC-RX components.

If you want to launch an individual component, select the appropriate script from
Table 5.

NOTE: The only valid license keys are those provided by Juniper Networks.

NOTE: All script names are one word, lowercase, and are located in the <NMC-RX
home>/utils directory.

Table 5:  Scripts for Solaris

Script Function

allnmcrx Affects the database, Polling service, ConfigSync service, and the NMC-RX
application

NOTE: This is the recommended way to start all NMC-RX services on
Solaris.

allservices Affects the database, Polling service, and ConfigSync service

configsync Affects the ConfigSync service

nmcrx Affects the NMC-RX application (has only start and console options)

nmcrxdb Affects the NMC-RX database

nmcrxdemodb Affects the NMC-RX Demo database

polling Affects the Polling service
Modifying Your License Keys
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Script Parameters
The scripts accept the following parameters:

Start
This is the default behavior of each script. If the script is called without any
parameters, it starts the appropriate application. If the application being started is
already running, it reports this to you and the script does not try to start the
application again.

In the scripts that affect multiple applications, pauses are added to be sure that the
database has been started before the system tries to start the next application in
line. Each application is checked for status, and if the application is already running,
that application is not started again.

Stop
The status of the application is checked, and if the application is running, it is shut
down. If the application is not running, you are notified that it is not running.

In the scripts that pertain to multiple applications, each application’s status is
checked. Those applications that are running are shut down, and those that are not
running display a message that they were not running. You are then notified
whether the application was successfully stopped or not. NMC-RX clients will not be
shut down.

Restart
The status of the application to be restarted is checked. If the application is running,
it is stopped and then started again. If it is not running, it is started at this point.

In the scripts that pertain to multiple applications, all applications are stopped.
NMC-RX clients are not stopped and restarted. Any clients currently running are
notified that the database connection has been lost and that they need to be
restarted.

Console
When this parameter is present on the command line, a new dtterm  terminal
window is started with the name of the application. The application’s console
output is displayed in this window.

NOTE: The NMC-RX script does not support this option.
Using Solaris Scripts 19
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Status
This parameter reports whether or not an application is running. In the case of the
multiapplication scripts, this parameter displays the status for each application
checked.

Help or ?
Each of the parameters display the script’s command line parameters.

Reverting to a Previous Software Installation

If you chose the NMC-RX upgrade option during installation, you have the capability
of reverting to a backed-up version of the NMC-RX software later. During
installation, backup application files are saved to an installation-specific folder in the
rpbk directory, located in the installation directory. A revert script is also included in
this directory.

If you need to revert to a previous version, run the script nmc-rx-revert in the folder
of the version you want to revert to. For full installation upgrades, all data entered
into the application between the dates of the upgrade and the date you are
performing the reversion will be lost (a warning is displayed beforehand). For
client-only upgrades, no warning appears because no database information is
stored on a client-only system.

Exiting the NMC-RX Application

When you have finished configuring your E-series router and have saved the
changes you want, you can exit the application.

To exit the NMC-RX application:

1. From the Network Workshop, choose Exit from the File menu.

2. Click Yes in the confirmation dialog box.

NOTE: The NMC-RX script does not support this option.
Reverting to a Previous Software Installation
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